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1. Introduction 
 

CommNet is a program allowing data transfer from one or more LSI LASTEM instruments of the  

BabucABC to PC in manual/automatic way, also via modem. 

In case of manual calls the user starts the communication. In case of automatic calls, the program 

itself automatically calls the instruments according to the set configurations.  

The data so obtained can be saved in an ASCII file (TXT format), apt for being imported 

immediately to the program CommNet Display or other program as InfoPanel, or are saved in an 

Access database compatible with the software InfoGAP or in the Gidas database of SQL Server 

2005.  

 

NOTE 

This version of the program has been released to facilitate the use of a mixed net of instruments 

Babuc ABC and E_Log with memorization of the data in the new database Gidas of SQL Server 

2005 
 

 

2. System Requirements 
 

The program requires the following hardware and software characteristics: 
 

Personal computer 

 

• Operating system: Microsoft Windows 2000/XP/Vista/2003 Server. 

• Microsoft .NET Framework V. 2.0 (supplied with the program). 

• Physical RAM memory: minimum 128 MB, 256 MB recommended. 

• Space available on Hard disk: 100 MB. 

• Processor with working frequency 600 MHz or superior, recommended 1 GHz. 

• Video card: SVGA res. 1024x768 or superior. 

 

 

Data loggers 

 

• Babuc ABC V. 3 and following. 
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3. Installation 
 

First of all check the required system characteristics. For the operative systems Windows 2000 and 

Windows XP it is necessary to login with system administrator rights otherwise the product 

installation will be incorrect. 

 

Then, install CommNet starting the Setup program from the CD CommNet. The installation 

program will supply the necessary instructions for its completion. It is possible either to install 

immediately the product  and, afterwards, to install the Microsoft .NET framework, or viceversa. 

 
 

3.1. Organization of the installed files 
 

The installation procedure creates some folders starting from the chosen folder during the 

installation (default c:\Program files\LSI-Lastem\CommNet). They are: 

 

• Bin: it contains the executable files CommNet, CommNet Config and CommNet Display and 

some support files. 

• Doc: it contains the program documentation (included the user’s manual). 
 

Other folders will be created in c:\Documents and Settings\All Users\Applications Data\LSI-

Lastem\CommNet; this folder is kept hidden from the operative system; in order to show it go to 

folder properties and select “Show hidden files and folders”. New folders are: 

 

• ASCIIData: it contains the ASCII files where the program stores the data acquired from the 

instruments. 

• Config: it contains the program configuration files. 

• Statistics: it contains the statistic files created by the program. 

 

Next folder will be created in c:\Documents and Settings\[User Name]\Applications data\LSI-

Lastem\CommNet, where [User Name] is the name of the user logged in the Windows system: 

 

• Log: it contains the log files created by the program. 
 

 

Note: in Windows Vista the folder c:\Documents and Settings\All Users\Application data is equal to 

c:\ProgramData. 
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4. Foreword 
 

The program is divided into three separate modules: CommNet,  CommNet Config and CommNet 

Display. 

CommNet is the program used for the instrument communication and the data recording; CommNet 

Config is the program used for the configuration of the CommNet; finally CommNet Display is the 

program used to show the instantaneous values acquired by CommNet. 

 

Because CommNet work, it is necessary that: 

 

• The licence file for every instrument exist; 

• The Babuc instruments have a survey in progress and the survey must be “with 

memorization”. 
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5. CommNet Config: program 

configuration 
 

The working modality of CommNet can be set through the program CommNet Config; it allows to 

set: 

 

• The calls to one or more instruments; 

• The calls to one or more groups of instruments; 

• Paths and format of the data storage. 

 

The program allows to create one or more different configuration files, according to particular 

communication necessities; only one of them is anyway considered predefined and so can be used 

in a particular moment by CommNet. At the suitable moment  it is possible to select, as predefined, 

another one of the files previously set, so the communication modality of the program can be 

changed very quickly.  

 

 

5.1. Create the configuration file 
 

After the installation there is no configuration file “ready to use”. It is so necessary to create one. 

The operations to perform are:  

 

1. Start CommNet Config from the menu Start of Windows or directly from the program 

CommNet (choose Configure from File menu), choose Configurations… from File menu. 

2. Press the key New to create a new configuration file. Insert one name and, in case, a 

comment. 

 

 
 

3. Press the key Ok to save the changes. 
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4. Press the key Set as default to make possible that CommNet, once started, base its working 

on this configuration. 

5. Press the key Open to open the configuration. 

 

It is also possible to create other configuration files and, each time, set the predefined one (that is 

the one that will be used  from CommNet). 
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5.2. Instruments configuration 
 

To create a new instrument, perform the following operations: 

 

1. Choose Add-> Instrument from the menu Edit to add a new instrument. 

 

 

 

2. Set the instrument parameters (Type, Serial Number, Firmware version). In the current 

version of the program the only supported instrument is BabucABC; omit the initial zero of 

the serial number (i.e. digit 120 for the serial number 0120). For more information, refer to 

the instrument user’s manual.  

3. Set the kind of connection. In case the instrument is connected via modem, it is first 

necessary to set in the system, through the Windows control panel or in another way, the 

modem that will be used for the connection; on the contrary the connection setting mask will 

not present any modem configured.  If the connection takes place  via radio or RS485 or line 

driver, it is necessary to manage manually the RTS signal setting the parameters Start 

activation time (Act. Ant.) and End de-activation time (Deac. De), in milliseconds, as 

suggested in the instrument user’s manual. 

4. Set the speed transmission (managed automatically if the connection takes place via 

modem), and protocol identifier (as configured in the instrument). For more information 

look at the instrument user’s manual. 

5. Press Apply to save the changes. 

 

This operation has to be repeated in case other instruments have to be configured. 
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5.3. Calls configuration 
 

The calls planning is strictly connected to the instruments configured and to the necessity of having 

data available (elaborations and/or instantaneous values). 

 

Suppose, for example, to have three instruments, two of which configured for the connection via 

modem, and one for the direct connection. Of the first two instruments you desire to have the 

InfoGAP database daily updated, whereas of the second you desire to have the program InfoPanel 

updated every minute with the last data acquired. 

The solution is to insert two calls, one “daily”, and one “cyclical” (“repeatly”): the daily call 

configured to call the instruments connected via modem at a certain time of the day, and the cyclical 

one to call the one directly connected to the PC with the updating rate of one minute. 

 

The program allows the management of the calls at  the level of group of instruments. This can be 

useful in presence of instruments networks with different kinds of connections, either during the 

configuration phase and during the calls management. 

The instruments of the previous example, configured with the connection via modem, could be 

grouped in a group called “Instruments with modem”. Consequently in the daily call it will be 

enough to specify the call to that group. 

 

To create a  new call, perform the following operations: 

 

1. Choose Add>Call from the menu Edit to add a new call. At the beginning the program will 

propose a “daily” call with the PC time.  

 

 
 

2. Set the name of the call. It is possible to chose a free name. 

3. Set the call regularity (type and date-time or type and time rate). 

4. Set which instrument (or group of instruments) among those previously configured, must be 

subjected to this logic of call. 
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5. Enable or not the kind of data to require (Instantaneous values in case of use of the program 

InfoPanel, Elaborations in case of use of the program InfoGAP). The Instrument status is 

always request. 

6. Press Apply to save the changes. 

 

The operation has to be repeated in case there is the necessity to configure other kinds of calls for 

other instruments connected or that can be called via modem. 

 

 

5.4. Instruments groups 
 

In case there are more instruments connected and that can be called, it is possible to group these 

instruments in groups. In this way it is possible to set one group as a single instrument, setting a 

single call logic. For more information refer to the chapter 5.3. 

 

 
 

Choose Add>Group from the menu Edit to add a new group of data loggers. The choice takes place 

among those previously configured. The name of the group is free. 

 

Press Apply to save the changes. 
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5.5. Options 
 

In the program Options it is possible to choose the data storage format together with the relative 

paths (for the InfoGAP database it is necessary to store also the name of the database 

InfogenStor.mdb) and the statistic updating rate. 

 

 
 

Choose the storage format of the data (elaborated values) specifying the file storage path. If the 

storage is in ASCII file, there is the possibility to choose if store the data on different files (one per 

day for each quantity) or in a single file (a file on a unique period for each quantity). Moreover it is 

possible to choose if store the data inserting or not the names of the data fields (ex. (Min) 23.7; 

(Ave) 25.4; (Max) 27.8). 

 

If you want to show data with CommNet Display, or if CommNet is used together with the program 

InfoPanel, it is enough to transfer only the instantaneous data and store them into a Text file 

(ASCII). For more information about the use of InfoPanel refer to the relating Manual. 

  

If data have to be used together with the program InfoGAP, it is necessary to enable the storage into 

the InfoGAP Database. This option assumes that InfoGAP (and the relating database 

“InfogenStore.mdb”), is already installed on the PC, because CommNet cannot create a database 

autonomously. Moreover all the instruments must be already configured and enabled (licence 

“InfoGAP Advanced Level”). For more information about the use of InfoGAP refer to the relating 

help on line. 

 

The option of memorization on Gidas SQL database allows the saving of the data on the database 

Gidas of Microsoft SQL Server 2005 installed locally or on a server; the data can be visualized with 

the program GidasViewer. For the installation of the database the manual of this program is seen. 

To produce the connection string press the button  that will visualize the window of connection 

to the database Gidas. 
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Insert the name of the SQL Server Instance that it contains the database Gidas and press the button 

< Ok >. Use the Windows Authentication Windows if the database has been installed in the local 

PC. If the database was installed on a server use the indications furnished by the database 

administrator. 

 

Any change to the displayed parameters are  saved only if the key Apply is pressed. 

 

After configuring the instrument, possible groups of instruments, the calling modalities and the 

storage formats, the configuration is finished and is ready to be read by CommNet. 

 

If CommNet Config was started directly by CommNet, it is necessary to reload the configuration by 

CommNet, choosing Reload configuration from the menu File, otherwise the new changes will be 

ignored  until the next restart of the program.  

 

5.5.1. Configuration for CommNet Display or 

InfoPanel 

 

If you want to show data with CommNet Display, or if CommNet is used together with the program 

InfoPanel, it is enough to transfer only the instantaneous data and store them into a Text File 

(ASCII). 

 

The ASCII file can be stored locally or in a network folder. Choose a folder from the network if 

InfoPanel is installed on a different PC than CommNet. 
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For the data reading by InfoPanel, it is necessary to configure a data source for each instrument to 

display. The parameters  to be set are: 

 

� Type: ASCII file. 

� Instrument Id: the instrument serial number  (ex. 7228). 

� Enable data reading: enabled 

� Data source file path: the name (path included) of the instrument file Inst.txt (for more 

information refer to chapter 6.5.2). 

 

 
Setting example for the data reading from one instrument 

configured in CommNet. 

 

 

5.5.2. Configuration for InfoGAP 
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If data have to be used with the program InfoGAP, it is necessary to enable the storage into the 

InfoGAP Database. This option assumes that InfoGAP (and the relative database 

“InfogenStore.mdb”), is already installed on the PC, because CommNET cannot autonomously 

create a database. 

 

The database can be stored locally or in a network folder. After the first InfoGAP installation, it is 

created locally, unless the user chose differently, in the folder “C:\Program Files\LSI-

Lastem\InfoGAP\Database”. To have it in a network folder it is necessary to copy it from the local 

folder and set the new path through the  InfoGAP menu Utilities.  

 

All data are stored into the InfoGAP database according to the instrument serial number they come 

from. To use the data from InfoGAP, it is necessary to have the program Licence Keys (licence 

“InfoGAP Advance Level”) for each instrument. 

 

5.5.3. Configuration for  Gidas 

 

To use the database Gidas of SQl Server 2005, it is necessary to enable the storage in the GIDAS 

SQL Database. This option assumes that the database Gidas is attainable from the program 

CommNet that is not able to autonomously create the database. 

To create the database Gidas is necessary to use the program GidasViewer. 

 

ATTENTION: 

The storage in the database Gidas, natural support for the instrument E_Log, supports only the 

following elaborations: 

• 1Ist 

• 10Ist 

• 60Ist 

• Duration 

• Eolo2 

• Eolo3 

• Eolo4 

• Events Min,Miax,Delta, Pulse 

• Elaborations with  Min, Max, Ave, Stdev,Tot 
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6. CommNet: activate the data 

transfer 
 

The CommNet working modalities are all in the configuration file previously configured through the 

program CommNet Config while the data stored is shown by CommNet Display. 

 

CommNet, once started, shows itself  as in the picture below: 

 

 
 

The information are grouped in four sections; they are: 

 

• Manual data request 

• Communication devices 

• Data recording 

• Communications statistic 

 

 

6.1. Manual data request 
 

Even if automatic calls are set, the user has the possibility, in every moment, to perform a manual 

call. 

In details: 

 

� Instruments list: it is the list of the instruments available for connection. 

� Groups list: it is the list of the group of instruments available for connection. 

� Keys All/None: it allows to quickly select or unselect all the instruments or groups of 

instruments. 

� Box System status: automatically checked. During the connection the state of each selected 

instrument will be required. The information will be stored into the file 

“…\Date\<instrument name>\Status.txt”.  

� Box Instantaneous values: if ticked during the connection the last read (or received) values 

of the probes connected to each selected instruments will be required. The information will 

be stored into the file “…\Date\<instrument name>\Inst.txt”.  
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� Box Elaborated values: if ticked during the connection the stored elaboration of each 

selected instrument will be required. The information will be stored into the file 

“..\Data\<instrument name>\*.elab.txt” or even in the Access database of the InfoGAP 

program o SQL Server. 

� Box Only last elaborations: if ticked during the connection the elaborations from the set 

date-time in Elaborations from will be required. This option is active only if the box 

Elaborated values is ticked. 

� Elaborations from: date-time from which the elaborations will be required. This option is 

active only if the box Only last elaborations is ticked. 

� Key Call now: if pressed it will be started the connection to the instruments or group of 

instruments selected. 

 

 

6.2. Communication devices 
 

This section includes a table where the information regarding all the communication: name and 

state of the communication device used for the connection, name of the instrument currently 

connected, list of the instruments waiting for the connection on a specific device. Each table line, 

corresponds to a different communication device. In details: 

 

� Device: it is the name of the communication device used for the connection. It can be the 

name of a serial port (ex. “Com2”), or the name of the modem (ex. “Modem Standard 

9600”). 

� State: shows device state code (ex. “Idle” when it is in a waiting state or “CommRunning” 

when it is in a communication phase). 

� Current instrument: it is the name of the instrument to which it is connecting. 

� Queued instruments: it is the list of the instruments waiting. 

 

 
 

Initially the table is empty. The devices get added to the table after they are called from the program 

for the connection. Once the connection is terminated they are not removed but assume the state 

“Idle”. 
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6.3. Data recording 
 

The list present in this section shows the name of the instruments storing the elaborated values on 

the ASCII file or Database. As soon as this phase finishes, the name of the instrument is removed. It 

is not advisable to close the program when this list contains one or more names, because it would 

produce the lost of the data received by the PC. 

 

  

6.4. Communications statistic 
 

In this section it is reported the statistic on the connections made. The information change according 

to the instruments selected in the section Manual data request. In details: 

 

� Key Reset: it resets the statistic of the selected instruments. 

� Calculated from: it is the date-time of the beginning of the calculation of the selected 

instrument statistic; if more instruments are selected it shows the less recent date; 

� Last call: it is the date-time of the selected instrument; if more instruments are selected it 

shows the more recent date. 

� Last received elab.: it is the date-time of the last received elaborated values from the 

selected instrument; if more instruments are selected it shows the more recent date. 

� Total calls: it is the total number of calls performed by the selected instruments. 

� Failed calls:  it is the total number of failed calls from the selected instruments. 

� Failed communications: it is the total number of the communications whose communication 

has not positive end, relatively to the selected instruments. 

� Total connection time: it is the total time of connection of the selected instruments. It is not 

indicated the time necessary to the modem to get in connection with the remote modem. 
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6.5. Interpretation of the files generated 

from CommNet 
 

The files generated by CommNet are of three types: 

 

• LOG file 

• ASCII (TXT) 

• Statistic files 

 

6.5.1. LOG file 

 

The log file is EndUserLog.txt, located in the folder: “..\Log”. It is generated in automatic way from 

the program, where it details, all the performed operations. 

It can be read directly from CommNet, choosing Open Events Recording from the File menu. 

 

Each line is made up of the following information: 

 

� Date: in the format yyyy-mm-dd 

� Time: in the format hh:mm:ss,ms 

� Type of event: INFO (normal operations), ERROR (function errors found from the program), 

and DEBUG (settable only from LSI LASTEM) 

� Event description. 

 

 
 

After a prolonged period of time this file can assume, in function of the number of configured 

instruments and of the calls set frequency, quite big dimensions. If necessary, it is possible to delete 

it only after closing the communication program. 

 

6.5.2. ASCII File (TXT) 

 

The ASCII files generated by CommNet contains information about the instrument and, precisely: 

the state, the last instantaneous values, the elaborated values. 

The first two are automatically generated by the program at each request of the kind State of the 

instrument and Instantaneous values. The third, instead, is automatically generated only if the user 

chose to store the elaborated values with the request Elaborated values. 

All files are stored in the folder “..\Date\<instrument name>”. 
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6.5.2.1. Instrument status 

The information about the instrument status is contained in the file “Status.txt”. They are: 

 

� Last update: date-time of the last update 

� Program version: instrument version 

� Factory serial #: instrument serial number (not changeable) 

� User’s serial #: user’s instrument serial number (changeable) 

� Battery level: battery charge level (in V) 

� Memory free/total: available memory/total memory 

 

     
 

 

6.5.2.2. Instantaneous values 

The information with the last acquired values are contained in the file “Inst.txt”. They are: 

 

� UpdateTime: date-time of the last updated data refer to 

� SerialNr: instrument serial number 

� Ch<channel n. > <quantity name>: where <channel n.> is the channel number the data 

come from and <quantity name> is the datum quantity name. There are as much lines as the 

number of  channels. 

 

  
 

This file is the one that supplies the data form the program InfoPanel. 

 

6.5.2.3. Elaborated values 

The elaborated values are stored in one or more files depending on the option Store per day-

channel. If this is enabled they are stored on different files according to the day and channel. In this 

case the files are named “DyymmddCxxx.elab.txt” (yy is the year, mm is the month, dd is the day, 

xxx is the quantity channel number). 

 



LSI LASTEM CommNet – User’s Manual 

20 

 

 
Example of “elaborated” values of Babuc/A/M on 05/02/02 of the channel 1 (with field description). 

 

 
Example of “elaborated” values of Babuc/A/M on 05/02/02 of the channel 2 (with field description). 

 

 
Example of elaborated values of Babuc ABC on 16/09/04 of the channel 11 (with field description). 

 

 
Example of elaborated values of Babuc ABC on 16/09/04 of the channel 4 (with field description). 

 

 

If the option Store per day-channel is enabled the elaborated values will be all stored in the file 

“elab.txt”. 

 

 
Example of elaborated values of Babuc/A/M (all channels, with field description). 
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Example of  elaborated values of BabucA/M (all channels, without field description). 

 

6.5.3. Statistics files 

 

There is a statistics  file for each instrument. Its name is <name instrument>.xml and it is located in 
the folder “..\Statistics”. It is generated at the first call to the instrument and updated with the following calls. 

  

In the file all the information about the Statistics of the communications of the single instrument are 

stored. The same information are displayed by CommNet in the section Communication Statistics. 
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7. CommNet Display: show 

data 
 

CommNet Display is a program to show the instantaneous values stored by CommNet. 

 

The program can be started from the Start menu of Windows or directly by CommNet choosing 

Show Data from the menu File. 

 

Because CommNet Display shows the stations data, it is necessary have performed an instantaneous 

call to every stations, otherwise the windows with the relative values won’t come displayed. 

 

At the first run it is necessary to specify the path where the file/s ASCII is/are stored (default: C:\ 

Documents and Settings\All Users\Application data\LSI-Lastem\CommNet\ASCIIData). 

 

 
 

Then the program will show one window for each instrument stored. The window will contain a 

table with the following information: 

 

� C.: number of channel of the quantity. 

� Quantity: name of the quantity. 

� UM: measure unit of the quantity. 

� Date-time: it is the date-time of the last update to which  data refer to. 

� Date-time: it is the date-time of the penultimate update to which data refer to. 
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If CommNet Display has the updating rate lower than the calling rate programmed in CommNet, the 

two columns with the instantaneous values could be  identical. 

 

All the settings are saved in the configuration file IPBase.xml. 

Every time the program starts, it checks if the information of this file is the same of those stored in 

the file/s ASCII. 

In case of new instruments or channels respect to the file IPBase.xml, they will be automatically 

added to the configuration file.  

In case of different instruments or channels, they will substitute those existing in the configuration 

file. In this case, the customized information (i.e. the name of the quantity, the limits of  the alarm, 

and so on for the channel and the name of the instrument, the channels order, and so on for the 

instrument) will be lost. 

In case of missing instruments, they will not show yet while in case of missing channels, they will 

be automatically deleted. 

 

To delete an obsolete instrument from the visualization, it is necessary to access to the configuration 

and uncheck the check box Visualize of the relative instrument. To delete it also from the 

configuration, it is necessary to delete the folder corresponding to the original name of the 

instrument, in the path of memorization of the ASCII file/s. For further information refer to the 

chapter 7.1. 
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7.1. Customizing the visualization 
 

The visualization can be customized as follow: 

 

• To visualize only the desired instruments and the channels; 

• To visualize the instrument with the desired name; 

• To visualize the channels (quantities) with the desired name and in the desired order; 

• To set the alarm thresholds of the channels (quantities); 

• To set the colour, the size and the type of the character of the text; 

• To set the size and the position of all windows. 

 

To change the current visualization choose Configure… from the menu File. 

 

7.1.1. Instrument visualization 

 

In the section Original information are shown the information acquired by the CommNet program 

and stored in the file “Status.txt”. They cannot be modified. 

In the section Displayed information, instead, the parameters that can  be changed are shown . 

They are: 

 

� Visualize: enable or not the instrument to be displayed. 

� Name: it is the name of the instrument to display in the instrument window. 

� Channels order: it is the order in which display the channels (the quantities) in the table. To 

move a channel, select it and then press the button Move up or Move down. 

 

 
 

To save the changes, press Ok to exit from the configuration, otherwise press Apply.  

 

7.1.2. Channel visualization 
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The channel is the number of the channel associated to the quantity. 

In the section Original information are shown the information acquired by the CommNet program 

and stored in the file “Inst.txt”. They cannot be modified. 

In the section Displayed information, instead, are shown the parameters that can  be changed. They 

are: 

 

� Visualize: enabled or not the channel to be displayed. 

� Name: it is the name of the channel to display in the table of the instrument window. 

� Measure unit: it is the measure unit of the channel to display in the table of the instrument 

window. 

� Alarm: it specifies the type of alarm associated to the channel; if the alarm is enabled, 

different from “None”, it is necessary to set the lower and the upper limits. The alarms of 

the channels are active only if it is checked “Active alarms” in the Options.  

 

 
 

To save the changes, press Ok to exit from the configuration, otherwise press Apply.  
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7.1.3. Options 

 

In the Options are shown all the general settings of the program. They are: 

 

� Data path: it is the path where the ASCII file/s is/are stored (default: C:\ Documents and 

Settings\All Users\Application data\LSI-Lastem\CommNet\ASCIIData). 

� Update rate: it specifies how many seconds the program read the ASCII file/s. 

� Color of data in case of error: it is the color of the “Err” text that indicate data in error 

(default: red).  

� Color and font of the text in the tables: it is the color, the size and the type of the character 

of the text in the instruments table (default: color: black, character: Arial, size: 8, style: 

normal).  

� Active alarms: if it is checked, the program considers the alarms settled for each channels. 

� Colour of data in case of alarm: it is the colour of the text of the data if the channel is in 

alarm. 

 

 
 

To save the changes, press Ok to exit from the configuration, otherwise press Apply.  

 



Thank you for reading this data sheet.

For pricing or for further information, please contact us at our UK Office, using the details 
below.

  UK Office
Keison Products,

P.O. Box 2124, Chelmsford, Essex, CM1 3UP, England.
Tel: +44 (0)330 088 0560
Fax: +44 (0)1245 808399

Email: sales@keison.co.uk

Please note - Product designs and specifications are subject to change without notice. The user is responsible for determining the 
suitability of this product.

mailto:info@keison.co.uk
http://www.keison.co.uk



